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section 4.1

1. Introduction

The purpose of this application is to programmatically unfold a 3D object into its 2D net representation,
which can then be cut out using a laser guided cutter. The unfolded net will provide a physical template to
construct the 3D object in the real world. The software will allow users to import 3D models, interact with
them, and generate the net data for laser cutting.

1.1 Purpose

The main purpose of this document is to provide a clear, accurate specification of requirements and
important functionalities of the Unfold3D software. Within this document, the scope and purpose of
Unfold3D will be introduced before specifying what functionality is required along with various points of
design.

Identify the purpose of this document and the product whose software requirements are specified in this
document. Be sure to mention the version / revision / release number of the software and also mention if
the document covers all aspects of the software or only a small part of the software. Do not iterate over
the table of contents here. Give a general overview of what this document contains.

1.2 Intended Audience and Reading Suggestions

This Project under the CSULA senior design program is sponsored by the Army Research Lab. The
audience for this specification associated with this project is categorized into non-technical and technical
groups. Non-technical readers generally include those outside of the development team such as liaisons,




legal officials, advisors, or any test users. For this group, sections 1, 5, and 6 may be most useful.
Technical readers generally include those within the development team such as senior design team
members. All sections will be useful for this group. From this description, this document provides
suggested reading sequences for non-technical readers below.

1) Liaisons and advisors should read Section 1 before proceeding to Sections 2.1 to 2.5 and 2.7.
Finally, Sections 5 and 6 should be read.

2) Test users should read Section 1 before proceeding to 2.2 to 2.4 along with 2.7. Finally, Sections
3.1, 4.1, and 6 should be read.

3) Legal officials should read Sections 1 and 6.

1.3 Product Scope

The Unfold3D software will transform 3-D CAD models into ready schemas of mock military targets.
These ready-to-use schemas are then meant to be printed before assembly into solid objects so that
military personnel can train more effectively with appropriate supplies. However, the specified software
will not be directly used for military operations including intelligence or combat. Overall, the software
product should benefit U.S Army training ranges by providing an efficient, usable, and reliable toolchain
for the usage described above.

1.4 Definitions, Acronyms, and Abbreviations
NOTES
Acronyms & Terms List:

e Net: A two-dimensional pattern that can be folded to form a 3D object.
e FOSS: Stands for free and open source software and includes software under the GNU Public
License.

1.5 References
1.5.1 Web Resources:

e GNU Article of the GPLV3 terms and conditions: https://www.gnu.org/licenses/gpl-3.0.en.html
e OpenTk Official documentation: https://opentk.net/learn/index.html
e Mesh Voxelization article:

https://www.gradientspace.com/tutorials/2017/12/14/3d-bitmaps-and-minecraft-meshes



https://www.gnu.org/licenses/gpl-3.0.en.html
https://opentk.net/learn/index.html
https://www.gradientspace.com/tutorials/2017/12/14/3d-bitmaps-and-minecraft-meshes

2. Overall Description

2.1 System Analysis

The software must solve the problem of filling a tooling gap for the ARL and its related organizations.
Specifically, this unfilled tolling issue is the lack of a streamlined methodology to design and prepare
elaborate 3-D models of mock targets for manufacturing. The remainder of this section covers discussion
about the major goals and development obstacles.

A: Major Goals

e Provide a usable, accessible, reliable, and capable pipeline of software utilities to transform
elaborated target models into 3-D printable schematics.
e Uses low cost and/or open source alternatives to existing subscription-based, proprietary options.

B: Significant Technical Obstacles

1. The software must consider material strengths which may affect structural stability of the mock
target.

2. The software must use efficient algorithms to process the geometry of mock target models,
including mesh simplification, removal, smoothing, etc.

3. Not all components of a 3-D model can be simplified with certain algorithms such as decimation.
An example would be wheels that must be textured and rounded appropriately for functionality.

4. The software must appropriately draw fold lines on printable 2-D pieces.

5. The software must appropriately denote where tesseract frames will be placed within fully folded
pieces for stability.

C: Solutions

For Obstacle 1: Not yet determined.
For Obstacle 2: Not yet determined.

e For Obstacle 3: The current approach uses a user-guided selection algorithm in the Editor to
select, reposition, or separate mesh parts to process. For instance, this method can easily separate
wheels from the rest of a vehicle mesh that will be smoothed, so the wheels will remain
functional.

e For Obstacle 4: The current set of features also includes a functionality that exports the printable
2-D schemas as SVG or PDF with appropriate contours and folding lines.

e For Obstacle 5: Not yet determined.
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Product Perspective

Product Functions

Import Model: Allow users to import models with the .obj or .stl file format

Render Model: Allows users to render and view the .obj files in the 3D space

Change Settings: Allow user to customize their experience

Simplify model: Allow the user to simplify imported models

Delete Mesh: Allow the user to delete individual meshes from the imported model

Move Mesh: Allow the user to move/rotate a selected mesh within the application’s 3D space
Lock Meshes:Allows user to lock certain areas of mesh that they don't want to be altered
Create shapes: Allow the user to create 3d objects to replace parts on a selected mesh
Export Model: Allow users to export models in the .obj or .stl file format

Unfold model: Allows the user to convert the 3D model into a 2D representation as an SVG

User Classes and Characteristics

Novice User:
Frequency of Use: Expected to be often if the person is a designer or digital modeler.
Functions Used: The Model Editor’s various 3-D modeling tools e.g Part Mover, Deleter, etc.

Technical Expertise: Knows how to use software GUI and do basic file management e.g open,
close, add, delete, modify files.

Privilege Level: Depends

Experience Time: Under 1 year of usage.

Power User (Modeler or Designer with more programming knowledge & skills)
Frequency of Use: Expected to be often if the person is a designer or digital modeler.

Functions Used: The Model Editor’s various 3-D modeling tools e.g Part Mover, Deleter, etc.
Possibly, they can make Python scripts for the Blender component.

Technical Expertise: Knows how to use software GUI and do basic file management e.g open,
close, add, delete, modify files. Python scripting and thus some programming fundamentals are
likely included.

Privilege: Likely has access to classified ARL schematics of mock targets.

Experience Time: Over 1 year of usage.



2.5 Operating Environment

Overall, the Unfold3D software will operate on various desktop computer systems. Platform factors
comprise a significant part of the operating environment. Those specified here that can or will affect the
software’s operation include hardware specifications, native OS, and available software. First, hardware
specifications can affect performance and runtime support for the software. The architecture must possess
enough computing power to run the graphic-intensive programs. Specifically, the GPU and CPU must be
relatively modern: a multi-core CPU with a recently manufactured GPU model (at most 6 years old) is
recommended. Second, the native OS must be a supported platform for certain dependencies such as
OpenCV. Third, the available software upon the OS must match the chosen ones used to develop the
software. Examples of this include support of selected programming languages, any libraries to process
model formats, and other tools or dependencies.

2.6 Design and Implementation Constraints

This section provides constraints impacting the design and implementation of the Unfold3D. These
constraints include non-functional requirements and limitations that must be addressed during
development

OS Constraints
- Currently, the whole software is developed and runs on Windows systems only.

Higher-Order Language Requirements

- The organization of the software requires C# and Python. This may limit the software from using
libraries and tools from other languages and require adapting certain features from those
languages to the ecosystem of the software.

Interfaces with other applications

- Blender
Hardware limitations

- Must run on a laptop possessing an adequate graphics card for OpenGL 3.3+.

2.7 User Documentation

Core Documentation:



1. SRS as PDF
2. Optional: User Guide as PDF

2.8 Assumptions and Dependencies
Assumption 1: We are going to use .obj and .stl formatted files.

Assumption 2: We are going to have to export our final product in a .svg or similar file format.

2.9 Apportioning of Requirements
Possibly Delayed Requirements:

1. Implementation of an automated algorithm to map the surface of a target model.
a. This will be delayed for now because the more advanced topic of Artificial Intelligence
was considered for this requirement.
2. Implementation of an algorithm to deduce how tesseract frames will pack interior spaces of the
assembled target.
3. Implementation of configurations for the exported SVG file to meet requirements



3. External Interface Requirements

3.1 User Interfaces

Primarily, the Unfold3D software will use GUIs for users to effectively utilize it. As an interactive,
graphical application, there will be various components of the overall Ul for various purposes. Such
various purposes are to provide an introductory splash screen, a tooling interface for the Mesh Editor, and
other tool menus for purposes such as exporting simplified models as 2-D formats. Overall, the GUI
design guidelines and descriptions of the important components will be covered.

The design guidelines are as follows:

1. The GUI should be accessible to a wide range of users including those with disabilities.
2. The GUI should be simple for intuitive usage. In other words, the learning curve must be gentle.
3. The GUI should be visually pleasing to users.

Initial GUI:
Splash Screen:

e This screen will appear for at least three seconds to allow any user to digest relevant credits and
the Unfold3D logo.

e The Application name will appear in larger, bold text for better readability. Additionally, the
version numbering will be included besides it.

e The crediting information (licensing) will be clearly listed below the software logo and title.

Main GUI (Editor):

Mesh Toolbar:
Contains buttons and sliders

e This will be a toolbar situated at the top of the application window
e It will contain most if not all of the buttons and menus needed for the application features

Mesh Viewer:

Selection highlights
Application Settings:
Colorblind compatibility mode
Keyboard Shortcuts:

e Undo: Ctrl+Z
e Redo: Ctrl + Shift +Z

Error messages:



Too many triangles to unfold

Imported 3D model is too large

3.2 Hardware Interfaces

Unfold3D software interacts with the hardware model indirectly. It simplifies a 3D model that the user
loads and the software simplifies it through several mesh simplification methods (*bounding box /
voxelization / mesh simplification*) and unfolds the simplified model using Blender scripts. The
software then outputs a file of the unfolded simplified model that will be compatible with the laser-cutting
machine.

Data Interaction

- The software doesn’t directly communicate with the laser cutter. Unfold3D instead communicates
indirectly by simplifying the 3D model and producing a file that contains the unfolded simplified
model, which is then loaded into the laser-cutting software.

Output Specifications

- (*DXEF or other file format*)

- Cutting Paths: Outer perimeter paths for laser-cutting, represented as continuous vector lines

- Folding Lines: Marked by dotted or dashed lines to indicate where the model should be folded

- Assuming that the user will determine which material to use, the software will not specify what
type of material the model needs

3.3 Software Interfaces
N/A

3.4 Communications Interfaces

N/A
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4. Requirements Specification
4.1 Functional Requirements

4.1.1 File Operations

1. Import Functionality
o The system shall allow the user to import 3D models in .obj format by clicking the
“Import” menu option or using the keyboard shortcut “Ctrl + O”.
o The system shall load the selected .obj file, parse its contents and render the model within
the application workspace.
2. Export Functionality
o The system shall allow the user to export models using the Export menu option or the
keyboard shortcut “Ctrl + E”.
o The system may provide multiple output formats such as PDF, SVG, or similar as
selected by the user.

4.1.2 User Interaction Modes

1. Move Mode
o The system shall enter “Move Mesh” mode when the user selects the corresponding tool
from the interface.
o  While in this mode, clicking and dragging a mesh shall move the mesh within the
application’s 3D space.
2. Rotate Mode
o The system shall enter “Rotate Mesh” mode when the user selects the corresponding tool
from the interface.
o While in this mode, clicking and dragging a mesh shall rotate the mesh within the
application’s 3D space.
3. Delete Mode
o The system shall enter “Delete Mesh” mode when the user selects the corresponding tool
from the interface.
o While in this mode, clicking on a mesh shall delete it from the current scene.
4. Undo Operation
o The system shall allow the user to undo the last action performed by clicking the “Undo”
button.
o The system shall restore the state of the scene to the moment prior to the last action.

4.1.3 Scene Management

1. Adding Geometric shapes
o The system shall allow users to insert predefined shapes (e.g., boxes or cylinders) into the
scene via the “Insert” menu.
2. Simplification
o The system shall allow the user to remove small meshes below a configurable size
threshold using a slider in the “Simplify” menu.
3. Bounding Box
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o The system may allow users to add a bounding box around the loaded model for
simplification purposes.
4. Restoring Scene State
o The system may remember the original state of the loaded scene and allow the users to
revert to it when required.

4.1.4 Rendering and Visualization

1. Rendering Modes
o The system may remember the original state of the loaded scene and allow users to revert
to it when required.
o The system shall switch rendering modes based on user selection in the “View” menu.
2. Shading Models
o The system shallot support multiple shading models (e.g, flat shading and smooth
shading) that can be toggled via the “View” menu

4.1.5 Unfolding Features

1. Paper Size Configuration
o The system shall allow users to configure the maximum width and height of the unfolded
model in meters through numeric inputs.
2. Output Filename
o The system shall allow users to specify a filename for the exported unfolded model
3. Export Formats
o The system shall provide an option to choose the format of the unfolded output (e.g, PDF
or SVG)
4. Automatic Adjustment
o The system may iteratively adjust the paper size if the specified dimensions are too small
to contain the unfolded model
5. Batch SVG processing
o The system shall process and export each unfolded panel as an individual file if the
selected format is SVG

4.1.6 User Interface Customization

1. Toolbar Positioning
o The system shall allow users to configure the position of the toolbar (e.g., top, bottom,
left, right) through the settings menu
2. Menu Interaction
o The system shall provide a responsive menu with toolstrips and input validation for
numeric values (e.g., paper size dimension)

4.1.7 Error Handling

1. Input Validation
o The system shall validate numeric inputs (e.g., paper size) to ensure they are within a
valid range.
o The system shall display a warning message if the input is invalid or missing.
2. File Loading Errors
o The system shall display an appropriate error message if an .obj file fails to load.
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3. Export Errors
o The system shall notify the user of any issues during the export process (e.g., file
permissions, missing paths)
4. Fallback Handling
o The system shall default to a safe state if unsupported configurations (e.g., unknown
toolbar positions) are encountered.

4.2 External Interface Requirements

Inputs:

e Name: Model Editor / Simplifier
o Purpose: To provide a thoroughly equipped environment for initially processing mock
target meshes in 3-D.
o Input Source: ARL Engineer or CAD Model Designer (gives a 3-D digital model).
m Data Format: OBJ, STL
o Output Destination: Model Converter stage
o Measurement Systems: metric (m) or imperial (in. & ft.)
e Model Converter / Flattener:
o Purpose: To export the processed mock target meshes as a flat, printable format.
o Input Source: simplified CAD model from Mode! Editor
m Data Format: OBJ, STL, Al (Adobe Illustrator), SVG
o Output Destination: Kongsberg X24 (laser cutter model)
o Measurement Systems: metric (m) or imperial (in. & ft.)

4.3 Logical Database Requirements

Most likely, the Target Model Pipeline software will not require a database. The previously mentioned
purpose of the software is to transform 3-D model data into a flat, 3-D printable format rather than store
data persistently. Thus, database requirements likely do not apply.

4.4 Design Constraints

The application must be able to be run on a laptop. Additionally, it must not require access to the Internet
and work as a stand-alone application that does not require technical skill to access.

13



5. Other Nonfunctional Requirements

5.1 Performance Requirements

e The number of terminals to be supported is 1
e The number of simultaneous users to be supported is 1
o Since it is a stand-alone application, only one user can use the tool at once.
e Amount of information which needs to be handled is 2, one of which is the OBJ or STL 3D
model which the user imports, and the other is the SVG file which the user should be able to
export after processing.

5.2 Safety Requirements

Since the application is a tool that can not cause loss, damage, or harm, there are no safety requirements
needed.

5.3 Security Requirements

This application must be able to be run offline, and all user data including models used should not be
collected.

5.4 Software Quality Attributes

e Usability
o Ease of learning

o Ease of use

e (Correctness

o Measurements should be precise when exporting after processing the model.
e Portability

o Application must not require an internet connection

5.5 Business Rules

All users can perform all functions of the application because it is a stand alone program which acts as a
tool for the user. Since it is a tool which does not require any administration or collection of user data, no
rules are needed to which functions the user can perform.
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6. Legal and Ethical Considerations

6.1 Ethical Issues:

As of the current writing time of this document, the USA indirectly involves itself in various armed
conflicts around the world. These armed conflicts have controversy over civilian casualties or escalation
of conflict with some nuclear-capable nations including Russia. To any who hold anti-war stances, the
causation of both current or possible negative outcomes from contributing to war efforts must be
considered. Specifically for those opposed to war, the main issue of determining ethical work of this
project will be discussed.

Certainly, the Unfold3D project has sponsorship by the Army Research Lab for streamlining the supply of
mock targets for drills. However, this project will produce software for processing of any digital 3-D
models to flat printables. Thus, the expected software will not necessarily aid military efforts, so any
contribution to this project will not necessarily contribute to any harm. Furthermore, positive outcomes
are possible in two cases: Civilians or private companies may find this software useful, and the military
can be trained better in case of an incoming attack. The efforts of the development team must reflect this
by keeping the software generalized for both military and peaceful means.

To conclude, contributing to Unfold3D is ethically sound. This is because the software will be unfocused
to war efforts which cause harm to some individuals and can be used to benefit people and businesses in
peaceful usage. Still, this conclusion only holds if the software is developed with this general focus.

6.2 Legal Licensing Issues:

Oftentimes, software projects will contain a license explaining the intellectual property rights and other
considerations for users. This is important from a legal perspective for many issues including intellectual
property, policies on code modifications, etc. This subsection will thus give considerations specific to
licensing this software.

Most importantly, a given requirement from the ARL liaison was that the software must be built on FOSS
alternatives to current proprietary and/or paid options. The two most well-known notices for FOSS
software would be the GNU Public License (GPLv3) and the BSD (Berkeley Software Distribution)
License. Despite both being permissive, these two have some key differences. First, the BSD license
permits the software to be in proprietary (non-disclosed) ownership or usage as well, yet in its Preamble,
the GPL requires that:

“...you must pass on to the recipients the same freedoms that you received. You must make sure
that they, too, receive or can get the source code.”

The GPL clearly states that any entity that receives the software must have unrestricted access to the
source code. It is possible that Unfold3D may be proprietary on transfer of ownership to ARL personnel,
yet only the 3-D models are certainly classified information. The requirement of exposing the source code
by GPL terms may be desirable in respect to the earlier statement, but any specific mock target designs
must be kept separate from the software. Furthermore, any sensitive-code-names must be removed before
release to avoid leakage of classified information. Therefore, either license is the best option for the
software given that condition.
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Appendix A: Glossary
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Appendix B: Analysis Models
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Appendix C: To Be Determined List

Collect a numbered list of the TBD (to be determined) references that remain in the SRS so they can be
tracked to closure.
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